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1- X91+ IŞIK VE TUŞ TAKIMI
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2- LT30 KONTROL ÜNİTESİ İLE X91 GNSS ALICISININ EŞLEŞTİRME

Kontrol ünitesi ve X91+ cihaz düğmelerine basılarak açılır. Kontrol ünitesinden Start > Settings tıklanır. Açılan sayfanın altında bulunan sekmelerden Connections seçilir.

Açılan Settings penceresinden Bluetooth ikonu tıklanır.
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Gelen yeni ekranda Add New Device tıklanır. Ardından Bluetooth arama penceresi gelir ve açık olan X91 seri numarası ekranda görüntülenir.
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Ekrandaki seri numarası seçilir ve Next tuşu tıklanır.
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Güvenli bağlantı ekranı gelir. Buraya her hangi bir şey girilmesine gerek yoktur. Passcode boş iken Next tıklanır ve gelen ekranda bağlantışı kabul etmek için Yes butonu tıklanır. Ardından gelen ekranda Cancel tuşu tıklanır.
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Tekrar gelen uyarı için Advanced tıklanır.
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Açılan ekranda Serial Port işaretlenip Save butonu tıklanır.
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Bu işlem bittikten sonra gelen ekranın alt kısmından COM Ports sekmesine geçilir ve gelen ekranda New Outgoing Port tıklanır.
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Cihaz seri numarası seçilerek Next tuşu tıklanır.
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Port altında COM5 gibi port numarası seçilir ve Secure Connection işareti kaldırılır. İşaretlenmemiş olarak bırakılır ve Finish tuşuna basılır. 
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NOT: Burada seçili olan port numarası daha sonra X91 için kullanılacak yazılımların ilgili bölümlerinde de aynı seçilmelidir. Aksi takdirde LT30 kontrol ünitesi ile X91 alıcısı arasında Bluetooth bağlantısı kurulamaz.
3- CORS AYARLARI

Cihaza ilk kez CORS ayarları girip başlatmak için öncelikle kullanılacak olan kontrol ünitesi ile X91+ GNSS alıcısı ile 1. ve 2. bölümde anlatıldığı şekilde bluetooth eşleştirmesinin tamamlandığından emin olunur.
3.1- CORS BAĞLANTI AYARLARI VE ŞİFRE GİRME İŞLEMLERİ

1- Starttan HCGPRSCE tıklanır. Bluetooth eşleştirmesi yapıldığında ayarlanan port, port kısmında seçilir ve USE Bluetooth işareti kaldırılıp tekrar işaretlenir. Alt kısımda Prog yazan yerin yeşil dolması beklenir.
2- Work Mode GPRS Mode seçilir ve Set Mode tıklanır. Alt kısımda Prog yazan yerin dolması beklenir.
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3- Ekran üst kısmından GPRS sekmesine tıklanır. Ekrandaki kutular sırayla şu şekilde doldurulur.

Protocol: Cors,
Mode: Rover,
Server IP: 212.156.70.42
Port: 2101

APN Name: Hattınızın apn adıdır (mgb veya internet’ tir. Hattı aldığınız GSM Operatöründen öğrenebilirsiniz).

Mobile Server No:*99***1#
User Name: gprs

Password: gprs

Base ID: Boş bırakılır ve set tıklanır.
Alt kısımda Prog yazan yerin dolması beklenir.
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4- Ekran üst kısmından Cors Sekmesine tıklanır. Ekrandaki kutular sırayla şu şekilde doldurulur.
Protocol: Embed Tcp/IP seçilir.
Log Mode Auto seçilir.
Name: Kadastrodan verilen kullanıcı adı altta bulunan sanal klavye açılarak yazılır.

Password: Kadastrodan verilen şifre altta bulunan sanal klavye açılarak yazılır. Şifre büyük küçük harfe duyarlıdır.

Source list: Bu bölüme VRSCMRP yazılır.
Diff. Type: CMR seçilir ve Set tıklanır.

Alt kısımda Prog yazan yerin dolması beklenir.
Sağ üstten ok tıklanarak program kapatılır.
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4- YENİ İŞ DOSYASI AÇMA
1- İlk olarak X91+ GNSS Alıcısı açılır ve uydu ışığı mavi yanıp sönene kadar yani cihaz uydu görene kadar beklenir. Cihaz uydu görmeye başladıktan sonra Kontrol Ünitesi açılıp Starttan RTKCe programı çalıştırılır. HCGPRSCE programında Log Mode Auto yapıldığı için cihaz her açıldığında CORS’ a otomatik bağlanır ve sabit istasyon bilgisi ekrana gelir. OK linkine tıklanır.
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2- Ana menüden Dosya > Yeni İş tıklanarak yeni iş dosyası oluşturulur. 
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3- Açılan pencereye alt kısımda bulunan sanal klavye yardımıyla İş İsmi girilir. Datum kutucuğundan geçerli datum seçilir. Saat Dilimi 2 seçilir ve OK denir. Programın ana menüsünün alt kısmına bakıldığında cihazın Fix’i ve açılan İş ismi görülür.
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5- MEVCUT İŞ DOSYASINI AÇMA
Daha önce çalışılmış olan bir iş dosyayı açmak için Dosya > İş aç tıklanır.
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Açılmak istenen iş dosyası bulunur. Dosya bulunurken gelen ekrandan RTKCe > Projects seçilir.
[image: image23.jpg]Yeni is

Is ag

s kaydet =
Farkli kaydet fem|

Gegerli is ozellileri

Gegerli datum parametreleri

&
Yikle 00

Aktar
Cikis

Nokta siniflandir





Cihazda bulunan tüm iş dosyaları ekranda görülür. Çalışılmak istenen iş dosyasının kenarındaki (+) işaretine kalem yardımıyla basıldıktan sonra .rpb uzantılı dosya seçilir ve ardından OK butonuna tıklanır. Böylece çalışılmak istenen iş dosyası açılmış olur.
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6- NOKTA ÖLÇME
Arazide nokta ölçmek için ana menüden Ölçme > Nokta Ölç tıklanarak ölçüm ekranına geçilir.
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Eğer epok sayısı (ölçü süresi) değiştirilmek istenirse alt kısımdan Ops yazan yere tıklanır ve ölçü süresi kısmı kaç Epok isteniyorsa yazılıp OK denir. Ayarlamadan Ölç tıklanırsa cihaz otomatik olarak 5 sn sonra ölçümü tamamlayacaktır.
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Nokta adı girilir. Kullanıcı nokta adına yeni bir isim vermediği sürece program nokta adını otomatik olarak birer birer arttırır. Yöntem kutucuğu Ölçme Noktası seçilir. Anten yüksekliği olarak Jalon yüksekliği girilir. Ölçme yeri kutucuğu Bottom of Antenna seçilir ve Ölç butonuna tıklanarak nokta ölçülür. Bu menüden çıkmak istenirse İptale tıklanır.
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Ölçülen, elle girilen yada bilgisayardan cihaza yüklenen dosyaları görmek için ana menüden Dosya > Eleman Yönetici > Nokta yönetim tıklanır.
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7- APLİKASYON
NOKTA APLİKASYONU
1- Aplikasyon yapabilmek için noktalara ihtiyaç vardır. Cihaz ile daha önce ölçülen bir noktayı, el ile cihaza kaydedilen bir noktayı yada bilgisayardan cihaza aktarılan bir noktayı aplike edilebilir. Cihaza noktaları eklemek için 2 yöntem vardır.
2- NOKTALARI ELLE GİRMEK: Cihaza noktaları elle girmek için ana menüden Edit > Noktalar tıklanır.

Açılan pencerede Nokta adı yazılır. Yukarı (x değer) ve Sağa (y değer) değerler girilir. Eğer Yükseklik (z değer) biliniyorsa yazılır eğer bilinmiyorsa Yükseklik değeri 0 “sıfır” olarak girilir ve ardından Kayıt butonuna tıklanır.
Not: Eğer kullanıcı elle girdiği noktaları aplike yapmak istiyorsa ve aplikasyon menüsünden “Yakın” komutunu kullanacaksa Kontrol noktası kutucuğunun işaretlenmesi gerekmektedir. Birden fazla nokta için yakın komutu kullanılmak isteniyorsa aynı işlem her nokta girildikten sonra tekrarlanır.
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NCN DOSYASI YÜKLEMEK: Cihaza ncn uzantılı nokta dosyası yüklemek için kontrol ünitesini ara kablosu yardımıyla bilgisayara bağlanır. Kontrol ünitesi Windows 7 olan bir bilgisayara bağlandığında LT30 PocketPC olarak görülür. Eğer bilgisayarda Windows XP yüklü ise LT30 Windows Mobil Aygıtım olarak görülür. Yüklenmek istenen ncn uzantılı dosyayı kopyalayıp LT30 içindeki Storage Card (Hafıza Kartı) klasörünün içine yapıştırılır. Burada dikkat edilmesi gereken husus hazırlanan ncn dosyasında koordinatlar X, Y, Z sıralamasında olmalıdır.
Kopyalama işlemi bittikten sonra RTKCe programı açılıp 4. kısımda anlatıldığı şekilde yeni bir iş dosyası oluşturulur. Kopyaladığımız noktaları programa yüklemek için Dosya > Yükle > Grid Nokta yolu izlenir.
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Gelen ekrandan Dosya formatı İsim X Y H seçilir. Dosya ismi kısmından 3 noktalı kutu resmine tıklanıp Type All Files seçilir. Kopyalanan dosya bulunup seçilir.
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Gelen ekrandan OK tıklanır ve kopyalamış olduğumuz dosyadaki noktaların yükleme işlemi tamamlanmış olur. 
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Noktaların yüklenip yüklenmediğini kontrol etmek için ana menüden Dosya > Eleman Yönetici > Nokta yönetimi yolu izlenebilir. Bu menüden ölçülmüş olan, el ile girilen yada cihaza yüklenen tüm noktalar görülebilir.
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Aplikasyona başlamak için ana menüden Ölçme > Nokta aplikasyonu seçilir. Açılan boş ekranın alt kısmından Ekle tıklanır.
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Gelen listeden Tüm noktalar işaretlenir ve OK basılır. 
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Aplikasyon yapılmak istenen nokta listeden seçilir. Birden fazla koordinatı seçmek için klavyeden Shift tuşu kullanılabilir. Koordinatlar seçildikten sonra Aplikasyon tıklanır. Ekran alt kısmında bulunan Yakın komutu tıklanırsa cihaz kullanıcının konumuna göre en yakın noktaya yönlendirir.
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Noktaya hareket etmeden önce ekranın alt kısmından Ops. açılır ve yön kutucuğu Yön seçilip OK tıklanır. Yön kutucuğunun seçilmesinin amacı kullanıcının yürüyüş yönüdür. Başka bir deyişle kullanıcının sağı aynı zamanda cihazında sağıdır. Bu ayar da yapıldıktan sonra ekrandaki uyarılar takip edilerek nokta tespit edilir. Noktaya 1-2 m mesafe kaldığında program sizi daire içerisine alacaktır. Dairenin merkezi gideceğiniz nokta, “x” işareti ise bulunduğunuz yeri gösterir. “x” işareti dairenin merkezine geldiğinde sesli uyarı gelecektir. Böylece aplikasyon tamamlanmış olur.
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REFERANS HAT APLİKASYONU
Cihazla referans hat aplikasyonu yapmak mümkündür. Yani 2 nokta arasında belirli aralıklarla nokta işaretlemesi yapılabilmektedir. Bunun için ana menüden Ölçme > Diğer > Ref hat Aplikasyonu yolu izlenmelidir.
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Bu menüye girildikten sonra Başlangıç Noktası içinde üç nokta bulunan kutucuğa tıklanarak seçilir. Aynı şekilde Son Nokta da seçilir ve Aplikasyona tıklanır. Ekranda başlangıç noktasından son noktaya doğru ok şeklinde Seçilen Hat görülür. 
Ekranda görülen mesafe değeri başlangıç noktasından olan uzaklığı, ofset değeri ise hattın ne kadar dışına çıkıldığını gösterir. Mesafe takibi yapılarak istenen mesafede ölçüm alınabilir.
8- KALİBRASYON (İmar Koordinatı yada Ed50 Koordinatı Çalışmak)
Kalibrasyon (ED50 yada İmar Koordinatı çalışmak) yapabilmemiz için koordinatı bilinen noktalara ihtiyaç vardır. İmar koordinatı için 3 nokta, ED50 koordinatı için ise en az tek nokta yeterlidir. ED50 için istenirse birden fazla da koordinat eklenebilir.

Kalibrasyona başlamadan önce anlatılan şekilde yeni bir iş açılır. Yeni iş dosyası açıldıktan sonra Ayar > Gezici Par. > Gezici Opsiyon açılarak VRS kullan kutucuğu işaretlenip OK basılır.
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Kalibrasyon için kullanacağımız nokta/noktalar Edit > Noktalar kısmından eklenir. 
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Örnek olarak 2 noktadan kalibrasyon işlemi yapacak olursak.
Arazide ED50 koordinatı bilinen p1 noktamız var ve bu noktanın koordinatları Yukarı: 4000000.000, Sağa: 500000.000 ve Yükseklik: 1000 olsun. Bu noktayı anlatıldığı cihaza el ile giriyoruz. Cihaza el ile girdiğimiz p1 noktasını CORS ile ölçüyoruz. CORS ile ölçtüğümüz aynı noktaya p2 ismini veriyoruz. Dolayısıyla p2 noktası p1 noktasının ED50 koordinatına karşılık gelen ITRF koordinatı olmaktadır. Birinci noktanın ölçümü bittikten sonra arazide bilinen 2. noktaya gidilir.
[image: image50.jpg]LandStar & Vi 44 ok
GPS | Yatay hata|Diisey h.

CHl 1] D
Kalibrasyon datumu:TR 33 ITRF

_*/
ot e () 2000

Fix Y:0.003;D:0.004;RMS:0.004

iptal EQ




[image: image51.jpg]LandStar

Grid Isim: [
Kodlama: )
Yukari X: ?
Saga Y: ?
Yiikseklik ?





Aynı şekilde Edit > Noktalar dan 2. nokta da cihaza el ile girilir. Bu noktanın ismine de p3 adını veriyoruz. p3 noktasının koordinatları da Yukarı: 4500000.000, Sağa: 550000.000 ve Yükseklik: 1050 olsun. İkinci noktaya da cihaz koyulup CORS ile ölçülür. Ölçtüğümüz bu noktaya da p4 ismini veriyoruz. 
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Nokta ekleme ve ölçüm işlemleri tamamlandıktan sonra Ölçme > Kalibrasyon tıklanır. Gelen ekranın alt kısmından Ekle denilir.
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Açılan ekrandan Grid İsmi kısmının yanındaki 3 noktalı kutudan birinci noktamızın yani elle eklenen p1 ED50 veya İmar Koordinatı seçilip OK tıklanır.
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Bu nokta seçildikten sonra ekranın sağ alt tarafında bulunan 1/2 ye tıklanarak 2. sayfaya geçilir. Burada gelen ekran da GPS İsim olarak belirtilen yere içinde üç nokta bulunan kutucuğa tıklanarak eklemiş olduğumuz noktaya karşılık gelen ITRF koordinatı seçilir. Yani p1 noktasına karşılık gelen p2 noktasını seçiyoruz. Ardından OK tuşuna basıyoruz.
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Ekranda seçtiğimiz noktaları tek satırda görülebilir. 2. nokta da ekranın alt kısmında bulunan Ekle tıklanarak aynı işlemler tekrarlanır.

[image: image60.jpg]& | Landstar

@
*p3 p4 0.000 0000 YD
Zul I [ T»

Kalibrasyon datumu:TR 33 ITRF

— £ w0t4/190m (1) “I” 2.000( Hrt

-} 50%




[image: image61.jpg]X Gegerli datumun (zerine yazilsin mi?





Cihaza el ile girilen p3 ve buna karşılık ITRF koordinatı olan p4 noktası seçilip OK tıklanır.
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Nokta ekleme işlemleri bittikten sonra sağ alttan Hesapla kutusuna tıklanır. Cihaz hesaplamayı yapar ve hata oranlarını sıfıra düşürür. 
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OK tuşuna basıldığında Geçerli Datum Üzerine Yazılsın mı diye uyarı gelecektir. OK denilir ve Kalibrasyon işlemi tamamlanmış olur. Bundan sonra yapılacak tüm okumalar dönüşümü yapılan koordinat sistemine göre olacaktır.
[image: image66.jpg]2% | LandStar & Vi €4 ok

LD

— F
2A0%

Diisy. hesap

GEOID

ERI6/18¢, () “|" 2.000

:0.004;RMS:0.003




Her yeni iş açıldığında mevcut datum da yapılan dönüşüm otomatik gelir. Eğer dönüşüm kullanılmayacak tekrar ITRF ölçüm yapmak istenirse Dosya > Geçerli Datum Parametrelerine girilir.
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Ekranın sağ üst kısmında bulunan yatay oklar yardımıyla önce Yaty hesp içerisinde bulunan Yatay Hesaplamanın tiki kaldırılır. 
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İkinci olarak da Düşy. Hesap açılır ve Düşey Hesaplamanın tiki kaldırılıp ardından OK tıklanır. Böylece ITRF koordinat sistemine tekrar geçiş yapılmış olur.
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Yapılmış olan bu kalibrasyon cihazın hafızasına kaydedilip daha sonra aynı yerde kullanılmak için tekrar yüklenebilir. Başka bir deyişle ED50 yada İmar Koordinatı çalışılan yerde aynı işlemler tekrarlanmaz. Bunun için ana menüden Dosya > Aktar > Ürün seçilir.
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Gelen ekrandan Kalibrasyon dışındaki tüm yazıların tikleri kaldırılır ve OK tıklanır. Name kısmına kaydedilmek istenen isim yazılır. Location kutucuğu Storage Card seçilir ve Save tıklanır. 
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Ekrana Aktarma başarılı uyarısı gelir. Böylece yapılmış olan kalibrasyon kaydedilmiş olur.
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Kalibrasyon yapılan bölgede tekrar çalışılmak istenirse daha önce anlatılan şekilde ister yeni iş dosyası açılır istenirse daha önce o bölgede yapılan çalışmanın iş dosyası açılır. Kaydedilen kalibrasyonu çağırmak için Dosya > Yükle > Ürün yükle yolu izlenir.
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Kaydedilen dosyaya çift tıklanır ve Yükleme tamamlandı uyarısı ekrana gelir OK tıklanıp bu ekran kapatılır.
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Bundan sonra yapılacak işlem Ölçme > Kalibrasyon menüsüne girip sağ alt tarafta bulunan Hesapla butonuna tıklayıp OK butonuna basılır ve gelen uyarıya OK denilip kalibrasyon dosyası tekrar yüklenmiş olur.

9- ÖLÇÜLMÜŞ NOKTALARI CİHAZDAN BİLGİSAYARA AKTARMAK
Ölçülmüş noktaları bilgisayara aktarmak için ana menüden Dosya >-Aktar > Noktalar denir.
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Gelen ekranda koordinat görünümü Grid seçilir. Aktarım dosya adı yazan kısma dosya hangi isim ile kaydedilmek isteniyorsa resimde görüldüğü gibi ismi yazılır. Aktarım dosya tipi İsim Y X H seçilir ve ardından OK tıklanır. Bu şekilde okumalar cihaz içine dat formatında kaydedilmiş olur.
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Kaydetmiş olduğumuz dosyamızı cihazdan bilgisayara alabilmek ve dosya tipini değiştirmek için LT30 kontrol ünitesi bilgisayara bağlanır. Resimdeki yol izlenerek dosyaya ulaşılır.
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Dosya uzantısını değiştirmek için dosya ya yeniden adlandır denilip sonunda ki .dat silinir ve yerine .ncn yazılır. Eğer dosya uzantısı görülemiyorsa aşağıda bulunan resimdeki yol izlenerek dosya uzantısının görülmesi sağlanır.

Uzantısı düzeltilen çalışma dosyası kopyalanıp bilgisayarda istenilen bir yere yapıştırılır. Dosya NETCAD de açılabilir.
10- X91+ İLE RTK ÇALIŞMAK
X91+ Sabit Olursa

X91+ üç ayak sehpaya kurulur ve açılır. Kontrol ünitesi ile X91+ ’ın bluetooth eşleşmesinden emin olduktan sonra Starttan HCGPRSCe programına girilir.
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Use Bluetooth kutucuğunun tiki kaldırılıp eşleştirdiğimiz COM (Genellikle COM5’ tir) işaretlenir ardından Use Bluetooth kutucuğu tekrar işaretlenir. Ekranın alt kısmında bulunan Prog yerinin dolması beklenir. Cihaz bilgileri ekrana geldikten sonra WORK MODE kısmı Transparent yapılır ve SET MODE tıklanır. Alt kısımda Prog yerinin dolması beklenir.
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Bu ayar yapıldıktan sonra ekranın üst kısmında yer alan Radio sekmesine geçilir. Cur Freq (Mhz) kısmına 430 - 450 arasında bir değer girilir. (Aynı değerin gezici olarak kullanılacak cihazda da girilmesi gerekmektedir). Baud Rate 9600 ve Powerset 1W seçildikten sonra SET linkine tıklanır ve Prog kısmının dolması beklenir. 
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İşlemler bittikten sonra sağ üstten OK deyip HCGPRSCe’ den çıkılır. Starttan RTKCe programı çalıştırılır.
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Program açıldıktan Dosya > Yeni İş yolu izlenerek yeni bir iş dosyası oluşturulur. Ana menüden Ayar > Sabit Par > Sabit Opsiyon seçilir.
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Açılan ekrandan anten yüksekliği cihazın kurulduğu noktadan cihazın etrafını saran mavi şeride çekilen metre ile ölçülen eğik değer yazılır. Anten tipi X91 seçilir. Son olarak Ölçme yeri Bottom of notch seçilir ve OK tıklanır. Eğer cihaz pilyeye veya jalon sehpası yardımıyla kurulduysa Cihazın alt kısmından ölçüm yapılır ve Ölçüm yeri Bottom of antenna seçilir.
[image: image92.jpg]Save As

Name: rtkegitim

Folder: [None M

Type: RAWSZH (*.RAW) %

Location:  |Storage Card M
Cancel





Bu işlem bittikten sonra ana menüde bulunan Ölçme > Sabiti başlat tıklanır. Açılan ekrana Nokta adı yazılır. Noktanın koordinatları biliniyorsa koordinatlar girilir. Eğer koordinatlar bilinmiyorsa ekranın alt kısmında bulunan Burası kutucuğuna basılır koordinatlar geldikten sonra OK tıklanır. 
Burası komutu işaretlendiğinde gelen koordinatlar yaklaşık koordinatlardır. Ofis çalışmasında doğru koordinatlar program yardımıyla girilip düzeltilebilmektedir.
Ayarlanmış baz istasyonu uyarısı gelir böylece sabitin kurulumu tamamlanmış olur. Cihaz üstünde yeşil ışık yanıp sönmeye başlıyor ise bu cihazın yayın yapmaya başladığı anlamına gelmektedir.
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X91+ Gezici Olursa

Kontrol ünitesi ile X91+ ’ın bluetooth eşleşmesinden emin olduktan sonra Starttan HCGPRSCe programına girilir.
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Use Bluetooth kutucuğunun tiki kaldırılıp eşleştirdiğimiz COM işaretlenir ardından Use Bluetooth kutucuğu tekrar işaretlenir. Ekranın alt kısmında bulunan Prog yerinin dolması beklenir. Alet bilgileri ekrana geldikten sonra WORK MODE kısmı Transparent yapılır ve SET MODE tıklanır. Alt kısımda Prog yerinin dolması beklenir. Burada ki ayarlama bittikten sonra ekran üst kısmında bulunan Radio sekmesine geçilir. Burada bulunan Cur Freq(MHz) kısmına sabit için yazdığımız frekans değerinin aynısı yazılır ve Set tıklanır. Alt kısımda Prog yerinin dolması beklenir. Sağ üst kısımda ok tıklanarak program kapatılır. 
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Gezici olacak olan cihaz üstünde de yeşil yanıp sönmeye başlamışsa sabit olan cihazla bağlantı kuruldu demektir. Starttan RTKCe programı çalıştırılır ve yeni bir iş açılır. Yeni iş açıldıktan sonra Ayar > Gezici Par. > Gezici Opsiyona girilir ve Anten tipi X91 seçilir. Bu işlem tamamlandıktan sonra program kapatılıp yeniden başlatılır.
11- RTK HAM DATA AKTARIMI

Ölçme işlemlerimiz bittikten sonra Dosya > Aktar > RAW Dosya yolunu izleyerek RTK (Gezici) ile yaptığımız okumaları aktarabiliriz.
Açılan ekranın Name kısmına istenilen isim verilebilir. Location ise Storage Card seçilip Save tıklanır. Aktarma başarılı uyarısı gelir OK denilip program kapatılır.
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LT30 bilgisayara bağlanır ve Storage Card’ a aktarmış olduğumuz dosya bilgisayara yapıştırılır. LandTool.exe programı çalıştırılır. 
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Program açıldıktan sonra File > Open yolu izlenerek yada File yazısının altında [image: image105.jpg]| LandStar

Dosya

n T

N
e 1540

Olgme Hesap Cihaz
unnil

—*/g\mus o f°2.000

40%




blunan Klasör resmine tıklanarak bilgisayara kopyalanan dosya bulunarak açılır.
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Gelen ekranda koordinatlar görülür.

Eğer sabit olan cihaz Burası komutu ile kurulmuşsa Base bölümü açılıp gerçek koordinatlar girilir. Anten Type X91 seçilir. Gerekli düzenlemeler yapıldıktan sonra program menülerinde bulunan koşan adam ikonuna tıklanır ve değerler tekrar hesaplanır.
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Yapılan hesaplama bittikten sonra Rover sekmesinden değerler görülebilir.
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Elde edilen veriler sağ ok işaretine tıklanıp csv uzantılı olarak kaydedilir. İstenilen dosya elde edildikten sonra program kapatılır.
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Bu dosyayı da kadastro format programında açılarak gerekli dökümanlar elde edilir.
12- OFSET YAPMAK
Program ile cihaz ile ölçülemeyen bir noktanın koordinatı belirlenebilir. Koordinat verilmek istenen noktadan cihazın Fix olduğu konuma metre çekilir. Çekilen metrenin “0”sıfır tarafındaki ucu okunamayan noktaya yerleştirilir. Ardından Jalon metre üstündeki bir değere yerleştirilir. Bu değer önemlidir ve kullanıcının başlangıç noktasından koordinatlandırma yapacağı noktaya olan mesafesidir. Burada nokta ölçümü yapılır. Yapılan bu ölçüm Başlangıç Noktası olacaktır. 
Metre hareket ettirilmeden Jalon metrenin üzerinde “0” sıfır noktasına doğru herhangi bir noktaya konulur bunun için mesafe önemli değildir. Önemli olan hattı belirlemektir. 2. nokta ölçümü de yapılır. Ölçülen bu nokta da Son Nokta olacaktır. Ölçme işlemi tamamlandıktan sonra ana menüden Hesap > Nokta Hesapla yolu izlenir.
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Gelen ekrandan hesaplanması istenen noktanın adı İsim yerine girilir. Yöntem kutucuğu Baz Hattından seçilir. Başlangıç Noktası içinde üç nokta bulunan kutucuğa tıklanarak gelen listeden metre üstünde ilk ölçülen nokta bulunur ve OK tıklanır. Aynı şekilde Son Nokta da açılan listeden bulunur ve OK tıklanır. Ofset değeri olarak Başlangıç Noktasından yani ilk ölçüm yapılan noktadan koordinat verilecek noktaya olan ve metreyle ölçülen mesafe girilir. Dşy. Mes. ve Sağ/Sol Ofset değeri "0” sıfır girilir. Ekran sağ alt kısmında bulunan Hespla butonuna tıklanır. 
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Kayıt butonuna tıklandığında ölçülemeyen nokta koordinatlandırılmış olur. Açılan ekrandan İptal denilip ana menüye tekrar dönülür.

13. ORTOMETRİK YÜKSEKLİK (GEOİD) DOSYASI YÜKLEME
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Cihaza ortometrik yükseklik (KOT/GEOİD) dosyası yüklemek istenildiği zaman yüklenecek olan dosya kontrol ünitesi bilgisayara bağlandıktan sonra resimdeki yol izlenerek RTKCe içerisine yapıştırılır.
Program açılarak Dosya > Geçerli [image: image115.jpg]LandStar
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Datum Parametreleri yolu izlenir. 

Açılan ekranın sağ üst kısmında bulunan yatay ok vasıtasıyla en son bölüme yani Düşey Hesap sekmesine gelinir. Ekranın orta kısmında bulunan Geoid kutucuğuna tıklanıp atılan Geoid (KOT/YÜKSEKLİK) dosyası seçilir ve OK tıklanarak çıkılır. 
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